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1) Brainstorming in Inspiration 

a) From the Start menu, Choose Programs then Kidspiration or double-click the Kidspiration icon 
on the desktop. 

b) When you start the program, you will see the window on the right. 
c) To start new diagram, click the Picture button.  
d) The text inside the main idea will be  

highlighted.  Type Your Main Topic to replace  
the words First Idea.  For example, to create a character map, let’s 
type the name of a character such as Ralph from Beverly Cleary’s 
book The Mouse and the Motorcycle. 
 

2) Adding Ideas to Your Diagram  
a) Click the Your Main Topic (Ralph) to select it. 
b) To add two symbols that are connected to the Ralph symbol, click the Add Symbol button  

twice. 
c) Click one of the new symbols to select it, and then type the word 

loves.  
d) Click the other symbol to select it, and then type the word fears. 
e) Your diagram now looks like this:  
 

3) Saving Your Diagram 
a) From the File menu, choose Save.  Navigate to the Floppy A drive.  Name the file and click 

Save. 
b) Notice the new name of the documents now appears at the top of the page (Ralph.kid). 

 
4) Changing the Formatting  

a) Click on the symbol you want to change and from the Format menu. 
b) Use the formatting toolbar at the bottom of the screen. 

 
 

Note:  To select multiple symbols to change at once, hold down the Shift key as you  
select each one.   

Step by Step #1: Creating a Diagram in Picture View 
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1) Adding Picture to 

a) Click on the sym
b) On the Symbol 

arrows or left a
To see all the Sy
Choose Animal
 

2) Moving and Resiz
a) Move – Click a
b) Resize – Click t

corners. 
 

3) Changing the View
a) Click on the Ma

out of your diag
 
4) Adding and Deleti

a) Click on a blank
b) On the Symbol 
c) Click the Next L

your diagram ne
d) On the Symbol 
e) Click the Next L

your diagram ne
f) Select another s

or press Delete 
 

5) Customizing Symb
a) Adding Text - C

then type your w
b) Changing the C

 on th
change and then

 
6) Connecting Symbo

a) Click the fears s

b) Click the Link 
c) Click the owl sy
d) Click the loves 
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Symbols  
bol that you wish to change - Ralph 

Palette, locate the symbol you wish to use.  Click on the right 
rrows at the top of the palette to rotate through the different library.  
mbol Libraries by name, click the Pick Library button  .  

s and Plants and then click on the mouse. 

ing Symbols 
nd drag to place it where you would like. 
o select the symbol then click and drag in or out by one of the 

 Scale 
gnifying Glass  on the bottom left of the scroll bar to zoom in or 
ram. 

ng Unlinked Picture Symbols 
 area of the screen.   
Palette, click the Pick Library button   and then click Animals and Plants. 
ibrary button  until you find an owl, and then drag the owl symbol onto 

ars fears. 
Palette, click the Pick Library button   and then click Everyday.   
ibrary button  until you find a motorcycle, and then drag the symbol onto 

ars likes. 
ymbol to place on the screen.  To delete it, you may click the Clear button  
on the keyboard. 

ols 
lick the motorcycle symbol to select it and then click in the box below it and 
ord – motorcycle. 

olor - Click the motorcycle symbol to select it. Using the Symbol Colors 

e Formatting Toolbar at the bottom of the page, click the color you would like to 
 click a new color. 

ls Using Links 
ymbol to select it.  

Symbols button  to turn it on.   
mbol to create a link to it. 

symbol to select it and then click the motorcycle 
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1) Listening to

a) To turn o
b) To hear t

other wo
 

2) Record You
*To support 
them to a sym
a) Click the
b) On the S
c) To begin
d) Say, for e

When yo
e) To play t

 
 
 
 
 
 
1) Switching to

a) Click on 
b) In Writin

from top 
The owl 
words.  S
 

2) Add an Idea
a) Click fea

b) To add a 
c) Type the

 
3) Move an Ide

a) To move

grabber 
b) Move va

  
o create a link to it. 
 Links Symbols button to turn it off Step by Step #3: Listening and Recording Sounds 
echnology Tra
le - http://lttec

 the Ideas in Your Diagram 

n the Listen tool, click the Listen button . 
he computer read an idea in your diagram, click the fears symbol.  Repeat with the 
rds. 

r Own Words or Sounds 
emerging readers, Kidspiration allows students to record words or sounds and attach 

bol.   
 motorcycle symbol to select it. 
ound menu, click Record. 
 recording, click the Record button.  
xample, “Ralph rides his motorcycle in the hallways.”  
u are finished recording the sound, click Save. 
he recording, click the speaker  in the upper right corner of the motorcycle symbol. 

 Writing View

the Go to Writ
g View, the id
to bottom with
and motorcycl
ounds recorde

 
rs to select it. 

new idea, clic
 word vacuum

a 
 an idea, click 

hand  app
cuum cleaner

  
Step by Step #4: Writing View 
iner/Consultant Email - LToulon@LTTechno.com 
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ing View  on the toolbar.  
eas in your diagram are organized 
 your first idea – Ralph – at the top.  

e pictures have been converted to 
d are shown with the  icon. 

k the Add Idea  button. 
 cleaner. 

the left side of the idea.  When the 

ears, drag the idea to a new location.  
 so it is located below the fears idea. 
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4) Adding Details To An Idea 

*Notes are a great way to add more information about an idea.  You can add as many lines of notes 
as you wish. 
a) Click below the top line in the vacuum cleaner idea to add details. 
b) Type “Ralph hides from the vacuum cleaner under the bed.” 

 
 

5) Switch to Picture view 

a) To view your project in Picture view, click the Go to Pictures  button. 
b) You will see that the vacuum cleaner idea has been added to your diagram. 

 
6) Closing Your Project and Returning to the Kidspiration Starter 

a) Click the Kidspiration character in the top left corner. 
b) You will be prompted to save changes. 

 
 
 
 
*Categorizing and sorting are i
and easy. 
 
1) Starting a New Diagram a

a) From the Kidspiration
b) A new diagram opens w

c) Click the First Idea sy
delete it. 

d) Click the SuperGroup
shape to add it to your 

e) Now your diagram look
f) Click to the right of you
g) Add a second SuperGro

first one so you have 2 
position. 
 

2) Adding a Title to the Sup
a) Click the first SuperGro

are living. 
b) Repeat with the second

  
Step by Step #4: SuperGrouper 
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mportant skills for K-3 students; the SuperGrouper tool makes this fun 

nd Adding a SuperGrouper Category 

 Starter, click the Picture button  to start a new diagram. 
ith the First Idea symbol highlighted. 

mbol to select it and then click the Clear button  on the toolbar to 

er button  and then click the rectangle SuperGrouper 
diagram. 
s like this:  
r SuperGrouper category so it is not selected. 
uper category to your diagram just like the 
side by side.  You may need to drag them into 

erGrouper 
uper category to select it, and then type Things that 

 category, naming it Things that are not living. 
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3) Adding Symbols to a SuperGrouper Category 

a) From the symbol library, drag the objects onto the correct category.  

b) To remove the symbol, select it then click the Clear button . 
 
 

4) Viewing a SuperGrouper Diagram in Writing View 

a) Click on the Go to Writing View  on the toolbar. 
b) Titles of the SuperGrouper categories assume a top-level 

position. 
 
 
 
 
 
 
 
 
 
 
  
1) Hyperlinks 

a) After you type a URL, 
b) Click outside the symb
c) Move the mouse back t

visit the site. 
 
2) Using Spell Check 

a) From the Goodies men
 

3) Print Options 

a) Click the Student Nam
b) Type your name or oth

Numbers if desired.  
 

4) Exporting to Another Pro
a) From the File menu, ch
b) Choose .jpg. 
 

 

  
Step by Step #5: Miscellaneous  
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press the space bar.  It will be underlined and become an active hyperlink. 
ol or text box where you have typed the URL so it is no longer selected. 
o the URL until you see the pointy finger so you may click the URL and 

u, choose Spell Check. 

e button . 
er information you would like to appear on the page.  Click Print Page 

gram 
oose Export. 
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*An activity in Kidspirat
symbols in the Symbol P
outline.  This entire envir
access from the Starter W
screen layout at the time 
 
1) Using Existing Activ

a) Click the Kidspir
Starter. 

b) Under Activities,

c) Visit http://www.
 

2) Creating an Activity
a) Create the activit
b) From the Teache

 
3) Create a New Symb

* If you the kids to ha
symbol library and th
a) From the Teache
b) Return to the Tea
c) In the Category l

toolbar.  
d) In the New Libra

Land-Sea Animal
 

4) Edit the Symbol Lib
*This can be done in 
From Existing Librar
a) From the Teache
b) The library on the

menu at the top to
from.  For examp

c) Then select the “D
created above. 

d) To add symbols t
left.  You may us
 

  
Step by Step #6: Kidspiration Activities
gy Trainer/Consultant Email - LToulon@LTTechno.com 
//lttechno.com/dist200tech/schedule.html   Voice mail - 866-849-4882 

ion is like a template document.  The teacher creates a document with specific 
alette, specific color and preference settings, and the beginnings of a diagram or 
onment is then saved into an activity (template) file which the student may 
indow.  Upon opening the activity template, the student will see the exact 

the activity was saved. 

ities 

ation character in the top left corner to return to the Kidspiration 

 choose the category you would like. 

 
lttechno.com/links/kidspiration.html for more templates that you can download. 

 
y in the Picture or Writing View from the Starter menu.  
r menu, select Enable Teacher Menu. 

ol Library 
ve their own special symbols to complete an activity, you can create a custom 
en select it as the default library for the activities that you create or modify. 
r menu, select Enable Teacher Menu. 
cher menu and choose New Symbol Library. 
ist, click the category that you want the new library to be under on the Symbol 

ry Name box, type a name for the new library you have created.  For example, 
s. Click OK to save the library. 

 
rary 
a number of ways: 
ies 
r menu, select Edit Symbol Libraries… 
 left is the “Source” column.  Use the drop-down 
 select a library that you wish to take some symbols 
le, Animals – Animals 1. 
estination” library on the right column.  For example, the Land-Sea Animals 

o the Land-Sea Animals library, click and drag from the Source library on the 
e any of the libraries in combination.  (Animals 7 & 8 have sea animals.)   
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Importing a Graphic 
a) Click the Import Graphic button on the right. 
b) Navigate to where the graphic is saved.  Select it then click Open. 
c) You can select the size as Standard Symbol Size to match the others or import it as its actual 

size.  Click OK. 
d) The graphic is place in the Custom-User 1 library on the left (Source library).  Click and drag it 

to the Land-Sea Animals library. 
 

Paste Graphic 
a) Copy the graphic from its original location.  (Edit menu – Copy or right-click an image on the 

Internet then choose Copy) 
b) Click the Paste Graphic button.  The graphic is place in the Custom-User 1 library on the left 

(Source library).   
 

5) Selecting the Custom Library 
a) On the Symbol Palette, click the Pick Library button   and then click Custom. 
b) Click the Next Library button  until you find the Custom library you created for this activity. 

 
6) Adding Audio Instructions 

a) Click the Symbol or SuperGrouper container to add audio instructions to it. 
b) From the Sound menu, choose Record.  Record your directions. 

 
7) Labeling Symbols 

a) To automatically insert the names of symbols when the student switches to the Writing View, 
from the Teacher menu, choose Picture-to-Topic. 
 

8) Saving the Activity 
a) Return to the Teacher menu and choose Save as Activity.  
b) Chose the default settings that you want for the activity.   

Note:  Since the library was already chosen for this activity, you do not need to choose it again 
when given the choice of the Default Library. 

c) Chose the category that you want your activity to appear under, for example Reading and 
Writing. 

d) In the Activity Name box, type a name for your activity.  
e) In the Description of Activity box, type a description for the activity.  
f) Now click Finish.  The activity will now appear under the activities in the Kidspiration Starter 

window. 
 

9) Distributing an Activity to Multiple Computers 
*Copy the file from the Kidspiration Activity folder on the computer which you created the activity 
onto the Kidspiration Activity folder of any other computer.  Copy the library you created from the 
Kidspiration Libraries – Custom also. 
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